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1.  When to use this manual 

Use this manual for assistance in uploading XML files to your WAP site in order to update text information 
on specific pages using Grapevine’s iLoop Text Uploader (iTU). 
 
For help editing XML files, see Appendix A – Editing XML files on page 9. 
 
For assistance, please contact Grapevine: +27 21 702-3333 or email info@vine.co.za.  
 
 

2. Introduction 

Grapevine’s iLoop Text Uploader (iTU) is a dedicated web application that enables you to modify content 
on your WAP site by simply modifying /adding text to a Grapevine-supplied XML template file, and then 
uploading the updated file. If your changes  are incorrect, you have to make necessary corrections and 
upload these. It is therefore suggested that you back up the existing file so this can be used if necessary.  
 

Backup XML 
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Modify XML 

template 

Upload XML 
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20090901_union_news_backup.xml
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Test WAP site

Copy backup to 

XML template

Start

OK?No

End
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1 2 3 4

 

Figure 1 – 4-step process 

 
This document shows you how to use iTU. It assumes you have some knowledge of editing XML files. If not, 
see Appendix A – Editing XML files on page 9.  
 
Audience 
This manual is applicable to iTU users, company administrators and GVI administrators. 
 
 

3.  Prerequisites 

To use iTU, you need: 
 

 an iTU username and password 

 the URL to the iTU web interface 

 the relevant XML template files 
 
All the information you need to access and use the iTU web application will be in the email you receive 
from Grapevine when you are provisioned on the system.     
 

mailto:info@vine.co.za
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Note: For assistance, please contact Grapevine: +27 21 702-3333 or email info@vine.co.za.  
 
 

4. Editing your XML file 

Before you upload changes to your WAP site, you will have to edit the XML template file sent to you by 
Grapevine.  
 
You can use any text, HTML or  XML editor to edit your XML file. It is recommended you do not use a 
document editor like MS Word, or any editor that will add unwanted formatting information  to the file. 
Instead, there are a number of free XML editors you can download from the internet, e.g. XML Wrench 
((http://www.xmlwrench.com).  
 
You can also use MS Notepad, which ships with the Windows operating system.  
 
Below is a sample XML file and the corresponding sample WAP site it was used to update.  
 

<?XML version=”1.0" encoding=’ISO-8859-1"?>

<news>

<date>20 October 2009</date> 

<topic>

<region>Gauteng</region>

<info>Board meeting to be held at the Convention Centre 

in Cape Town on 31st
 
 October 2009 </info>

<region>Gauteng</region>

<topic>

<info>The proposal for a monthly update meeting has 

been approved. We will publish the date soon. </info>

</topic>

</news>
 

Sample XML file 
 

 
Sample WAP site 

 
To edit your XML file, you will need to understand what each XML tag means.  
 
Note: The tags used below are examples only. Your WAP site may not display news stories and may use 
completely different tags but the principle remains the same.   
 

iTU XMl tags 

Opening and closing tags Description 

<news> & </news> Boundary tags for the content on your WAP page 

<date> & </date> Date the XML file is uploaded to your WAP site via iTU, e.g., 20 October 
2009  

<topic> & </topic> A news segment, comprising a region or news category, and a news story 

<region> & </region> Region or news category, e.g., “Western Cape” or “General”. The word 
‘news’ is hard coded so you only need to identify the type of news  

mailto:info@vine.co.za
http://www.xmlwrench.com/
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<info> & </info> A news story , e.g., “Board meeting to be held at the convention ...” 

 
You need to update the text between the date, region and info tags.  
 
Tips: 

 Before editing the XML file sent to you by Grapevine, make sure you have a backup of the original. If 
your changes do not update your WAP site correctly, you will need to use the backup to reverse your 
changes.  

 It is recommended you change the Date field in your XML file to the date you edit and upload it so that 
you will be able to identify it as the correct version when you upload it to your WAP site. 

 

Important: Do not change the name of the file. If you do, iTU will upload your file but your WAP site will 
not be updated. This is because iTU cross-references your WAP site with an XML file name that is 
allocated by Grapevine. If you change the name, the upload application will not find the correct file.  

 
 

5. Logging in to the iTU web site 

When you have finished editing your XML file and are ready to upload it:  
 

1. Open your web browser and enter the following 
URL: 
http://gvrhapp0.vine.co.za/iloopTextUploader 

2. Enter your username. 
3. Enter your password. 
4. Click Login. 
 
All the information you need to access and use the 
iTU web site is in the email you received from 
Grapevine when you were provisioned on the system.     
 
Note: Your username and password are case- 
sensitive.  
 
If you have forgotten your password, click the 
Forgotten your password? link and enter your email 
address. If this address is in the iTU database, the 
system will send you an email with your password. 

 

 
 
 

6.  Checking your XML file 

Before uploading your file, you should check that it is a well-formed and valid XML file. To do this, you can 
open it in a web browser like Internet Explorer or Mozilla Firefox. The process of opening a file in Firefox 
and Internet Explorer is slightly different (and often slightly different between different versions of the 
same application too) but the principle remains the same.  
 
Note: The most common XML errors are unmatched starting and  ending tags, e.g. <region> and </region>, 
either by omission or misspelling.  These errors are usually caused by inadvertently overriding an existing 

http://gvrhapp0.vine.co.za/iloopTextUploader
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tag(s) when copying and pasting additional segments into an XML file, or by not checking the spelling of 
tags.  
 
It is therefore important that you open your XML file in a web browser to check if it is well-formed and 
valid. Following are examples of how these errors will be displayed in your web browser.  
 

Omitting a boundary <tag> 
 

 
 
Boundary tags are the outermost tags in the 
XML file, in this case <news> and </news>. In 
this example, the end tag </news> is missing.  
 

 
Internet Explorer error message 

 

 
Internet Explorer error message 

 
Misspelling a start or end <tag> 

 

 
 
Every start <tag> must have a matching end 
</tag>. If you misspell a tag, a match can’t be 
found for it.  In this case, the </topics> end tag 
does not match the <topic> start tag.  

 
Internet Explorer error message 

 

  
 

 
  

7. Uploading your XML file 

To upload your XML file:  
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1. To locate your XML file, on 
the iTU Home page, click 
Browse.  
 

 
 

 

2. This will open the Windows Explorer File Upload (Firefox) or Choose File (Internet Explorer) dialog 
box. Browse to the folder on your PC where you saved your XML file, select it, and then click Open. 

3. To preview the file you have 
selected, in the iTU 
application, click Next.  

 

4. In the Preview XML section 
you can view the first few 
lines of your XML file to 
confirm that it is the correct 
version. 
 
Tip: If you have correctly 
updated the Date field with 
the date you made your 
updates, you will be able to 
use this to verify that you 
are about to upload the 
correct file. 

 
5. If you are satisfied that you 

have selected the correct 
file, click Upload. If this isn’t 
the correct file, click Cancel 
to search for and upload a 
different file (go to Step 1 
above). 

 

 

6. If the upload is successful, a 
message will be displayed: 
‘Your xml has been saved 
successfully’.  

 

 
Note: Remember, a successful upload will instantaneously update your WAP site with the information 
contained in the selected file so, immediately after uploading your file, you need to browse your WAP 
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site and make sure that your XML file has indeed updated it correctly.  
 
If your changes are correct, proceed to Step 8 below.  
 
If the changes are NOT correct, you must upload the previous (backup) version of your XML file  
straight away. To do this, in Windows Explorer, locate the previous version of the XML file you saved 
as a backup. Rename the backup XML to the name of the current file and then, in iTU, proceed to 
upload the backup (see Step 7 below) by clicking the HERE link.   
 

7. Click the HERE link to upload 
another file, or click the 
logout link in the top right 
hand corner of the page to 
exit the iTU application.  

 

 

 

 
 
 

8. Testing your WAP page 

ALWAYS check your WAP site after uploading the edited file. If you’re getting an error on the page that 
should have been updated, there is a problem with the XML file you uploaded. You can reverse your 
changes by uploading the previous (backup) version of the XML file. Don’t forget to change the backup 
name to the original file name, which is the name of the template that was sent to you by Grapevine. Don’t 
forget to change the date in the XML file. 
 
 

9. FAQ – XML file editing 

How many items may I include in a file? 
You may include as many items as you wish, bearing in mind that the more items you include, the more 
information will be displayed on the WAP page and the more the user will have to scroll, which is 
uncomfortable for a mobile phone user.  
 
How many characters can each item be? 
Each item can be as long as you wish, but the longer your items, the more information will be displayed on 
the WAP page and the more the user will have to scroll. This may make your WAP site unfriendly to a 
mobile phone user. Remember that an SMS is 160 characters long and that alone often requires scrolling.   
 
What is the best editor with which to open my XML file? 
You can open your XML file with any text, HTML or XML editor, including MS Notepad, but it is 
recommended that you download a free XML Editor from the internet, e.g. XML Wrench 
(http://www.xmlwrench.com), which displays XML code in a user-friendly format. Do not use a document 
editor like MS Word.  
 
Can I change the name of my XML file?  
You can change the name of your XML file and it will upload successfully, but any changes you made will 
not be updated on your WAP site. This is because iTU cross-references your WAP site with an XML file 
name that is allocated by Grapevine. So, do not change the name of your XML file. If you have to upload a 
backup file, make sure you rename it to the name of the original XML file sent to you by Grapevine.  
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I would like to add other parameters to the XML file.  
You may not add other parameters to your XML file. If you wish to add different content to your WAP site, 
contact Grapevine support.  
 
What if my update ‘breaks’ my WAP site? 
Upload the file that you backed up. To do this, delete the current template and then rename the backup file 
to the name of the template. Don’t forget to change the date in the XML file. Upload your template as you 
did previously.  
 

Appendix A - Editing XML files 

1. Introduction  

Updating your WAP site is a four-step process you will need to follow every time you want to modify it. To 
do so, you will need to know about XML files and how to modify them because an XML file is what is used 
to update the content on your web site.  

 

Purpose of this appendix 
This appendix describes the layout of the XML template that you will be changing, and shows you how to 
back up, modify and test it.  In the body of this document you can read more about uploading your XML file 
using the iLoop Text Uploader in order to update your WAP site.  
 

1.1. What is an XML file?  

An iLoop XML file contains and describes text elements (which are simply strings of characters) that 
comprise the content of your WAP site. The XML file that you will modify will contain the  news stories on 
your site.  
 
An XML tag delimits the elements in an XML file. It is written between angled brackets. Tags come in 
matched pairs: an opening tag and a closing tag, which is preceded by a backslash (/). 
 
The news stories, for example, in your template will be written between info tags like this: 
 

 
 
An XML file only describes and transports text; it does not define the format of text or validate it. It is 
simply ‘read’ by a WAP site and the text displayed.  
 
An XML file comprises a header and a number of tags that delimit text elements so that the application 
knows where text starts and where it ends. In the example below, the XML file contains:  
 

 a header – standard for all XML files 

 the body of the WAP site content – delimited by the opening <news> and closing </news> tags and 
itself containing the following tags:  

o a date – delimited by the opening <date> and closing </date> tags 
o a news snippet – delimited by the opening <topic> and closing </topic> tags 
o a news region – delimited by the opening <region> and closing </region> tags 
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o a news story – delimited by the opening <info> tag and a closing </info> tags   

  

<?XML version=”1.0" encoding=’ISO-8859-1"?>

<news>

<date>20 October 2009</date> 

<topic>

<region>Gauteng</region>

<info>Board meeting to be held at the Convention Centre 

in Cape Town on 31st
 
 October 2009 </info>

<region>Gauteng</region>

<topic>

<info>The proposal for a monthly update meeting has 

been approved. We will publish the date soon. </info>

</topic>

</news>
 

Sample XML file 
 

 
Sample WAP site 

 
Note: The tags used above are examples only. Your WAP site may use different tags.  
 

2. Updating your WAP site 

The first time you update your WAP site, you will back up and then modify an XML template sent to you by 
Grapevine. The template will include sample text that you will need to change. Whenever you make 
subsequent changes, you will first back up and then modify the XML file most recently used to update your 
site; this is the last XML file you uploaded to your WAP site.  
 
Following this sequence means that: 
 

 You will be able to see whether the news currently displayed on your WAP site is correct.  

 You will always be able to revert to the previous version of your WAP site if the changes you make 
cause a problem. 

 You will always edit the XML template with the correct name required to update your WAP site. This 
is because the XML template sent to you originally was allocated a name that is cross-referenced by 
your WAP site and this is the file you will keep updating. You must not change this file’s name.  

 

Notes: 

 The original XML template you will use to update your WAP site will be attached to the 
email you receive from Grapevine when you are initially provisioned on the system.  

 Bear in mind when following the steps below that different software applications (e.g., 
browsers, editors, email applications, etc.) and different  versions of these applications, 
may look and behave slightly differently.  

 To illustrate the examples in this appendix, we are going to use an XML template called 
union_news.xml. We will use MS Notepad 2007 as our text editor.   
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2.1. Backing up your XML file 

Before modifying your XML template, you need to back it up so that you can back out your changes if they 
cause a problem on your WAP site. To do this, you need to make a copy of it. 
 
It is recommended you prefix the backup file name with today’s date and append it with the word backup, 
e.g., 20091103_union_news_backup.xml.   
 

 
 

2.2. Modifying your XML file 

To modify your XML file, you can use any text, HTML, or XML editor that can save the file as plain text with 
the proper file extension (.xml).  
 

Important: 
A plain text file displays all the characters present in the file, unlike document editors that 
contain hidden control characters, which are the embedded characters used to depict bold, 
underlined or italicised characters. It is not advisable to use a document editor like MS Word 
to edit an XML file as these embedded characters can cause unexpected display problems on 
web pages.  

 
Text editors commonly used to edit XML files include: MS Notepad, PSPad, TextPad.  
 
The advantage of an XML editor is that it displays XML with the tags highlighted in different colours and 
indented. You can download a free XML editor, e.g., XML Wrench, from the internet 
(http://www.xmlwrench.com). 
 
In the example that follows, we are going to modify an XML file called union_news.xml using MS Notepad, 
which ships with the Windows operating system.  
 
To open your XML file:  
 

 Click Windows Start > All Programs > Accessories > Notepad.  

 On the File menu, click Open. 

 In the Open dialog box, navigate to the folder where your XML file is saved. If you can’t find it in the 
folder you’re sure it was saved to, it may be that you are only viewing files with a specific extension. 
Make sure you have selected All files (*.*) at the bottom of the Open dialog box.  

 

 
 

 Select the XML file you wish to edit, and then click Open. 
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Note: In Notepad, after you open your XML file, make sure you select Word Wrap on the Format menu 
otherwise your XML code will all be displayed on one long line. 
 

2.2.1. Adding new content 

Occasionally you will want to add new content to your WAP site without changing the existing content. To 
add new content you will have to add extra news segments.  
 
News segments are bounded by an opening <topic> and a closing </topic> tag, and comprise: 
 

 a region (delimited by opening <region> and closing </region> tags)  

 a news story (delimited by opening <info> and closing </info> tags) 

 
 
To add new content to your WAP site: 
 

1. Make a backup of the current XML file referenced by your WAP site.  
2. Open the current XML file in a text, HTML or XML editor, e.g., MS Notepad 2007 or XML Wrench. 
3. In the editor, copy all the text between and including the opening <topic> tag and closing </topic> 

tag of a news story. This is a news segment.  
4. Paste this text in the position you want the news segment to be displayed, e.g.: 

 at the top of the page (after the opening <news> tag),  

 at the end of the page (before the closing </news> tag)  

 before another news story (before another opening <topic> tag), or after another news story 
(after a closing </topic> tag) 

Ensure that you don’t overwrite any tags.  
5. Now you can edit your new segment. Make sure you have edited the text between the region tags 

and info tags.  
6. Save your changes.  

 

2.2.2. Editing existing content 

Occasionally you will want to change existing content on your WAP site. Perhaps, for instance, you updated 
a news story incorrectly and you want to make a quick correction. 
 
To edit existing content: 
 

1. Make a backup of the current XML file referenced by your WAP site.  
2. Open the current XML file in a text, HTML or XML editor, e.g., MS Notepad or XML Wrench. 
3. In the editor, make your changes to the text between the relevant opening and closing tags. For 

instance, if you want to change the region, edit the text between the opening <region> tag and 
closing </region> tag.  

4. Save your changes. 
 

2.2.3. Removing content 

Occasionally, you may want to remove content that is no longer news. To do this, you will remove news 
segments.  
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News segments are bounded by <topic> tags, and comprise: 
 

 a region (delimited by opening <region> and closing </region> tags)  

 a news story (delimited by opening <info> and closing </info> tags) 

 
To remove content: 
 

1. Make a backup of the current XML file referenced by your WAP site.  
2. Open the current XML file in a text, HTML or XML editor, e.g., Notepad or XML Wrench. 
3. In the editor, highlight and delete all the text between and including the opening <topic> tag and 

closing </topic> tags of one or more news stories.  
4. Save your changes.  

 
Important: 

 If you want to remove all the current news stories on your WAP site and create new ones, make 
sure that you DO NOT DELETE ALL THE NEWS SEGMENTS (each one of which is bounded by opening 
<topic> and closing </topic> tags). Leave at least one segment in the file. You will use this segment 
as a template for yourself to create new news stories.   

 Ensure that you DO NOT DELETE THE BOUNDARY TAGS: <news> and </news>.  

 

2.3. Saving your XML file  

 
To save your XML file: 
 

 In Notepad, on the File menu, select Save. Do NOT change the name of the file.   

 
Note: NEVER change the name of the XML file you intend uploading to update your WAP site. Only a file 
with the original name and original tags will update your site. If you change the name of the file and upload 
it, you will receive a ‘Successful upload’ message but your WAP site will not be updated because when your 
content is uploaded, the upload application looks for the original file name allocated by Grapevine (and 
sent to you as a template).  
  

Notes: 

 Adding extra tags to an existing segment will not cause additional information to display 
on your WAP site. Only information contained within the original tags will be displayed.  

 The punctuation and case of the text you enter in the XML file will be precisely mirrored 
on your WAP site. You cannot reformat font type and text colour in the XML file.  

 Information on your WAP site will be displayed in the order that it’s listed in the XML file. 
So, if you have a list of news items and you’d like a new one to appear at the top of the 
page on your WAP site, you need to copy and paste the new segment (delimited by the 
opening <topic> and closing </topic> tags) at the top of the list in the XML file, once again 
ensuring that you’re within the boundary tags. In this case, the boundary tags are <news> 
and </news>.  
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Support 

 
If you need assistance, please ensure you have all the details of what you were doing in Text Uploader so 
that a support consultant can help you.  
 
For assistance, please contact Grapevine: +27 21 702-3333 or email info@vine.co.za. 
 

mailto:info@vine.co.za

